Developing Search Strategy for Systematic Review and Meta-Analysis

Annelissa Chin & Stephanie Ng
NUS Libraries

20 June 2019
The Medical Library Training Room, MD6 Level 5
Course Outline

1. About systematic review
2. Preparing an EndNote Library for Systematic Review
3. Defining A Focused Question
4. Identifying Sources to Search
5. Search Syntax
6. Subject Heading vs. Keyword search
7. Developing Search Strategy (with hands-on exercises)
   a. Pubmed
   b. The Cochrane Library
   c. Embase
8. Reporting the Search Process
9. Managing Search Results With EndNote
   - Remove duplicates
   - Export the Endnote Library to Excel
   - Backup
About Systematic Review?

A systematic review attempts to collate all empirical evidence that fits pre-specified eligibility criteria in order to answer a specific research question. It uses explicit, systematic methods that are selected with a view to minimizing bias, thus providing more reliable findings from which conclusions can be drawn and decisions made (Antman 1992; Oxman 1993).

What is meta-analyses?
Many systematic reviews contain meta-analyses. Meta-analyses is the use of statistical methods to summarize the results of independent studies (Glass 1976). By combining information from all relevant studies, meta-analyses can provide more precise estimates of the effects of health care than those derived from the individual studies included within a review (see Chapter 9, Section 9.1.3).

Ref: Cochrane Handbook for Systematic Reviews of Interventions
Steps To Conduct A Systematic Review

1. Formulate a focused question
2. Write your review protocol
3. Identify resources to search
4. Develop your search strategy
5. Run your search (PubMed, EMBASE, Cochrane, etc)
6. Export citations to EndNote
7. Delete duplicate
8. Title abstract screening
9. Full text screening
10. Critical Appraisal
11. Extract the data and synthesise the results
12. Interpret your findings
13. Publish and disseminate the results

LIBRARIANS PROVIDE GREAT HELP

RESEARCHER MUST WORK ON THIS
Before Doing A Systematic Review

Has a review been done before?

Search the systematic review databases:
- Prospero [http://www.crd.york.ac.uk/PROSPERO](http://www.crd.york.ac.uk/PROSPERO)
- Cochrane Reviews [https://www.cochranelibrary.com/](https://www.cochranelibrary.com/)
- PubMed
- Embase

Write & register your review
- Write your protocol
- Refer to the PRISMA for systematic review protocols (PRISMA-P) for reporting standard for protocols [http://www.prisma-statement.org/Extensions/Protocols.aspx](http://www.prisma-statement.org/Extensions/Protocols.aspx)
- Register your research (e.g. Prospero or Cochrane)
PREP

Customise settings in Endnote for Systematic Review
Create A New EN Library

1. Search Windows > EndNote
2. Click on File > New
3. Enter a filename e.g. SysRev (.enl)
4. Select location to save the library (e.g. on your Desktop)
5. Click Save
Moving & Saving Your EN Library

How to move?
Where?
Back-up

Raw files

My EndNote Library

Compressed file

EndNote X9 - [My EndNote Test Library.enl]

File Edit References Groups Tools Window Help
Next...
Open Library...
Open Shared Library...
Open Recent
Close Library
Save Ctrl+S
Save As...
Save a Copy...
Revert
Share...
Export...
Import
Print...
Print Preview
Print Setup...
Compressed Library (.enlx) ...
Exit Ctrl+Q

My EndNote Library.Data

.enlx
Customise Fields To Display Record #

EndNote Preferences

Change Case
Display Fields
Display Fonts
Duplicates
Find Full Text
Folder Locations
Formatting
Libraries
PDF Handling
Read / Unread
Reference Types
Sorting
Spell Check
Sync
Temporary Citations
Term Lists
URLs & Links

Fields to display in the library window

Position
Column 1: Record Number
Column 2: File Attachments
Column 3: Author
Column 4: Year
Column 5: Title
Column 6: Volume
Column 7: Journal/Secondary Title
Column 8: Last Updated
Column 9: Reference Type
Column 10: Name of Database

Field
Record Number
File Attachments
Author
Year
Title
Volume
Journal
Last Updated
Reference Type
Name of Database

Heading
Record Number

Note: Selecting the 'Figure' and 'File Attachment' fields will display an icon in the library window.

Display all authors in the Author field.
My Groups Feature (To Organise)

- Group 1
- Group 2
- Group 3
Defining a Focused Clinical Question

PICO framework
# PICO

A useful tool/framework for asking focused clinical questions

<table>
<thead>
<tr>
<th>P</th>
<th>AND</th>
<th>I</th>
<th>C</th>
<th>O</th>
</tr>
</thead>
<tbody>
<tr>
<td>Population</td>
<td>Interventions or exposures</td>
<td>Comparison</td>
<td>Outcomes</td>
<td></td>
</tr>
<tr>
<td>Patients Problems</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>How would you describe a group of patients?</td>
<td>What do we want to do with them?</td>
<td>What is the main alternative being considered, if any?</td>
<td>What are you trying to accomplish, measure, improve, or affect?</td>
<td></td>
</tr>
<tr>
<td>What is the problem?</td>
<td>What are they exposed to?</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

"PICO" stands for **P**opulation, **I**nterventions or exposures, **C**omparison, and **O**utcomes.
You are a pediatrician working in an emergency ward. During your daily practice, you are frequently faced with distraught children who have to undergo the common needle related procedures.

Now a new needle-free jet injection of lidocaine has been introduced into the market. “Just ask any child or parent who’s experienced the ‘soda pop thing’ before an IV start and you’ll hear them state that the needle “didn’t hurt at all.”

You ask if this is effective in minimising pain and distress associated with needle procedures compared to the other anaesthesia or sham treatment.
Clinical Question: What is the efficacy of jet lidocaine for children undergoing needle-related procedure?

<table>
<thead>
<tr>
<th>PICO Elements</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>PATIENT (P)</td>
<td>Children undergoing needle related procedure</td>
</tr>
<tr>
<td>INTERVENTION (I)</td>
<td>Jet administration of lidocaine</td>
</tr>
<tr>
<td>COMPARATOR (C)</td>
<td>Jet placebo or other anaesthesia procedure</td>
</tr>
<tr>
<td>OUTCOME (O)</td>
<td>Pain score, patient satisfaction, patient cooperation, length of cry etc...</td>
</tr>
<tr>
<td>STUDY DESIGN (S)</td>
<td>Randomised Controlled Trials (RCT)</td>
</tr>
</tbody>
</table>
The Evidence Pyramid

• Describes a hierarchy, where systematic reviews are seen as the most reliable form of evidence.
• Help you to consider the quality and reliability of evidence

Source: http://www.nhsevidencetoolkit.net/what-is-evidence/
Exercise 1: Plan Your Search

Define your clinical question using PICO
IDENTIFYING SOURCES

‘Where’ to search
Sources Of Information

**Information Sources**

- **Subject specific databases**
  - PsycINFO
  - CINAHL

- **Bibliographic databases**
  - PubMed
  - Embase
  - Cochrane Library

- **Hand searching**
  - Key journal/conference abstract

- **Reference list of key articles**

- **Gray/grey literature**
  - Trials registry, thesis, report, Meeting/conference abstracts, etc.

- **Consulting Expert**
  - Ongoing and Unpublished data

**ALL** relevant studies must be found by searching

Search strategy – **Refined, documented** (i.e. you must keep a record of all searches)

SEARCH SYNTAX

- Boolean logic
- Phrase searching
- Truncation/wildcards
- Parenthesis
Boolean Operators

**OR** -- either terms may be present → more results
e.g. cancers **OR** neoplasms

**AND** both terms must be present → fewer results
e.g. jet injection **AND** lidocaine

**NOT** → Use with caution*
e.g. Humans **NOT** animals
*Studies on both humans **AND** animals (intersection area) would be missed

**NOTE:** Boolean operators: AND, OR, NOT, must be entered in UPPERCASE in PubMed
More Search Syntax

PHRASE SEARCHING (using " ")
“J-Tip lidocaine”

TRUNCATION
Therap* → find therapy, therapies, therapeutic, therapeutics, etc.  
(Note: PubMed used only the first 600 variations.)

WILDCARDS (example in MedLine (OVID))
an?esthesia → find anesthesia or anaesthesia
Organi#ation  → find organization or organisation

BRACKETS/parentheses
jet AND ( lignocaine OR lidocaine )
SEARCH METHODOLOGY

Subject Headings (MeSH) vs. Keyword Search

Recap what you have learnt from PR3144
What is PubMed/MEDLINE?

PubMed

- PubMed comprises more than 29 million citations for biomedical literature from MEDLINE, life science journals, and online books.
- MEDLINE, largest component of PubMed (25 million records from 5600 journals)
- Search interface developed by the National Center for Biotechnology Information (NCBI) at National Library of Medicine (NLM)

MEDLINE

- Biomedical literature database covering the fields of medicine, dentistry, nursing and health care system
- Medline records are indexed using MeSH
- Updated daily – in press, ahead of print
- Coverage: US & 80 other countries

Free access at https://www.ncbi.nlm.nih.gov/pubmed
What is Medical Subject Headings (MeSH)

Using the NLM controlled vocabulary, Medical Subject Headings (MeSH), to index citations

Provides a consistent way to retrieve information
The MeSH Hierarchy

Entry Terms:
- Injection
- Injectables
- Injectable

All MeSH Categories
- Analytical, Diagnostic and Therapeutic Techniques and Equipment Category
  - Therapeutics
    - Drug Therapy
      - Drug Administration Routes
        - Injections
          - Injection, Intratympanic
          - Injections, Intra-Arterial
          - Injections, Intra-Articular
          - Viscosupplementation
          - Injections, Intrallesional
          - Injections, Intralymphatic
          - Injections, Intramuscular
          - Injections, Intracocular
            - Intravitreal Injections
            - Injections, Intraperitoneal
            - Injections, Intravenous
            - Injections, Intraventricular
            - Injections, Spinal
              - Injections, Epidural
              - Injections, Subcutaneous
              - Injections, Intradermal

Broader term
Narrower terms

If you need to expand your search, consider the Entry Terms (synonyms) in keyword search.

Other ways to find Synonyms
- Thesaurus
- Subject terms in Library catalogue and
- Key concepts or Descriptors (Author supplied)
- Find a review article and look for the “keywords” used to search the different databases

The + sign indicates that there are more specific terms under the subject

Injections, Jet
Biolistics
# What is Keyword

Example of list of possible keywords related to “jet administration of lidocaine”

<table>
<thead>
<tr>
<th>jet administration of lidocaine/lignocaine</th>
<th>Keywords on ‘jet injection’</th>
<th>Keywords on ‘lidocaine’</th>
</tr>
</thead>
<tbody>
<tr>
<td>jet</td>
<td>jet</td>
<td>lidocaine</td>
</tr>
<tr>
<td>J-tip</td>
<td>J-tip</td>
<td>lignocaine</td>
</tr>
<tr>
<td>needle-free</td>
<td>needle-free</td>
<td>xylocaine</td>
</tr>
<tr>
<td>“needle free”</td>
<td>“needle free”</td>
<td>xylocitin</td>
</tr>
<tr>
<td>“no needle”</td>
<td>“no needle”</td>
<td>dalcaine</td>
</tr>
<tr>
<td>needleless</td>
<td>needleless</td>
<td>octocaine</td>
</tr>
<tr>
<td>needle-less</td>
<td>needle-less</td>
<td></td>
</tr>
</tbody>
</table>
MeSH Versus Keywords

- Least precise
- Broadest
- Current (retrieve latest studies pending MeSH indexing)

- More precise
- Narrower
- Slightly dated (miss latest studies due to delay in indexing)

- Most precise
- Not recommended to use to build search for systematic review
Exercise 2: Plan Your Search

1. Identify relevant **MeSH terms** via MeSH database
2. Identify synonyms to build **keyword** search statement
Course Outline

1. About systematic review √
2. Preparing an EndNote Library for Systematic Review √
3. Defining A Focused Question √
4. Identifying Sources to Search √
5. Search Syntax √
6. Subject Heading vs. Keyword search √

7. Developing Search Strategy (with hands-on exercises)
   a. Pubmed
   b. The Cochrane Library
   c. Embase
8. Reporting the Search Process
9. Managing Search Results With EndNote
   ▪ Remove duplicates
   ▪ Export the Endnote Library to Excel
   ▪ Backup
DEVELOPING SEARCH STRATEGY

a. MEDLINE (via PubMed)
‘Intervention’ Terms - Construct The Search Strategy

1. To search MeSH terms for ‘I’ term (*Jet Lignocaine*)
2. To search the keywords for ‘I’ term
   a) Brainstorm for synonyms or related terms
   b) Combine similar concepts with ‘OR’ operators
   c) Search specifically in *title/abstract ([tiab])* field

<table>
<thead>
<tr>
<th>Concepts</th>
<th>MeSH</th>
<th>Keywords</th>
</tr>
</thead>
<tbody>
<tr>
<td>jet administration of lidocaine</td>
<td></td>
<td>jet</td>
</tr>
<tr>
<td></td>
<td></td>
<td>J-tip</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;needle-free&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;needle free&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;no needle&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;needleless&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;needle-less&quot;</td>
</tr>
</tbody>
</table>
### ‘Intervention’ Terms - Construct The Search Strategy

<table>
<thead>
<tr>
<th>Concepts</th>
<th>MeSH</th>
<th>Keywords</th>
</tr>
</thead>
</table>

**tiab** = search only in ‘title’ or ‘abstract’ filed of the database record
Search Strategy For ‘Intervention’ — Jet Administration Of Lidocaine

Combine **MeSH & Keywords** on similar concepts using ‘OR’
Combine different concepts (i.e. ‘jet’ AND ‘lidocaine’) using ‘AND’

<table>
<thead>
<tr>
<th>Intervention = Jet administration of Lidocaine</th>
<th>Items Found</th>
</tr>
</thead>
</table>

Date of Search 28/2/2019
### Search Strategy For ‘Population’
- **Children with fear of pain**

<table>
<thead>
<tr>
<th>Patient = Child/children/infant/paediatric with fear of pain (Combining MeSH and keyword)</th>
<th>Items Found</th>
</tr>
</thead>
</table>

Date of Search: 17/6/2019
### Combining ‘Population’ & ‘Intervention’ Terms

<table>
<thead>
<tr>
<th>Query</th>
<th>Items Found</th>
</tr>
</thead>
</table>

Date of Search in PubMed 28/2/2019
## THE Cochrane Randomised Controlled Trials Filters For PubMed & Ebase

### PubMed


http://work.cochrane.org/pubmed

### EMBASE

'crossover procedure':de OR 'double-blind procedure':de OR 'randomized controlled trial':de OR 'single-blind procedure':de OR (random* OR factorial* OR crossover* OR cross NEXT/1 over* OR placebo* OR doubl* NEAR/1 blind* OR singl* NEAR/1 blind* OR assign* OR allocat* OR volunteer*):de,ab,ti

http://work.cochrane.org/embase
Export From PubMed To EN: > 200 items

In PubMed

1. In PubMed, go to Send to > MEDLINE.
2. Select the items you want to export.
3. Click on the top part of the MEDLINE button to download the items.

In Endnote software

4. IMPORTING INTO ENDNOTE

   In Endnote, go to File > Import to import the text file which you have exported.
   Select ‘PubMed (NLM)’ as the import option.
   Click Import (see below).

   ![Import File Figure]

   - Import File: `pubmed_result.txt`
   - Import Option: PubMed (NLM)
   - Import All
   - Duplicates: Import All
   - Text Translation: No Translation
   - Import
EN: Annotating Record With Name of Database (After Exporting Results)

**Video on EndNote: Change and Move Fields** [https://youtu.be/bE-L-_SQg3Q](https://youtu.be/bE-L-_SQg3Q)
**EN: Organise Citations Using ‘Groups’**

In Endnote, select the citations, then right-click.

---

<table>
<thead>
<tr>
<th>Rec</th>
<th>Year</th>
<th>Author</th>
<th>Title</th>
<th>Journal/Secondary Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>2019</td>
<td>Kurita, ...</td>
<td>Comparison between a ... Endoscopy</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>2019</td>
<td>Heppt, ...</td>
<td>Nasal Valve Lift in Nasa... Facial Plast Surg</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>2019</td>
<td>Pervee...</td>
<td>MIF inhibition enhancement... Pediatr Res</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>2019</td>
<td>de Mes...</td>
<td>Comparison of temozol... Neuroendocrinology</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>2019</td>
<td>Homm...</td>
<td>Beneficial Effect of Earl... Int Arch Allergy Imm...</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>2019</td>
<td>Wallace...</td>
<td>The Effects of Probiot... Neuropsychobiology</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>2019</td>
<td>Kobaya...</td>
<td>Impact of Accumulated... Cardiology</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>2019</td>
<td>Campo...</td>
<td>Combined microscopy ... Micron</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>2019</td>
<td>Baker, ...</td>
<td>Spatial analysis of land... Sci Total Environ</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>2019</td>
<td>Barker...</td>
<td>Kinematic and kinetic ... Clin Biomech (Bristol)...</td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>2019</td>
<td>Beksaç...</td>
<td>Downgrading of Grade... Urology</td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>2019</td>
<td>Randall...</td>
<td>Authors response to Pa... Prev Med</td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>2019</td>
<td>Halilida...</td>
<td>Treatment Effect Sizes J Orthop Sports Phys</td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>2019</td>
<td>Albin, S...</td>
<td>Short-Term Effects of J Orthop Sports Phys</td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>2019</td>
<td>Hodges...</td>
<td>Hybrid Approach to Tr J Orthop Sports Phys</td>
<td></td>
</tr>
<tr>
<td>23</td>
<td>2019</td>
<td>Edge, S...</td>
<td>New and important ch... Expert Rev Anticance...</td>
<td></td>
</tr>
<tr>
<td>24</td>
<td>2019</td>
<td>Liu, X;...</td>
<td>The value of MYB as a Head Neck</td>
<td></td>
</tr>
<tr>
<td>25</td>
<td>2019</td>
<td>Jaffa, C...</td>
<td>Fluorination of Mxene ChemSusChem</td>
<td></td>
</tr>
<tr>
<td>26</td>
<td>2019</td>
<td>Hwang,...</td>
<td>Aquablation of the pro... Cochrane Database S...</td>
<td></td>
</tr>
</tbody>
</table>
How To Save Searches / Set Email Alerts

- Click ‘Sign in to NCBI’ on the top right corner of the PubMed Homepage
- Register for an NCBI account or login in via partner organization account (e.g. Google login)
How To Save Searches / Set Email Alerts

- Review search **History** and pick best search strategy to save
- Save searches & receive automatic e-mail alerts

Refer to video at https://youtu.be/WbFjV91YNNY
Exercise 3: Run Your Search

1. Construct search strategy using the appropriate Boolean operators to structure your search
   #1 Patient(P) ➔ combine MeSH & Keyword with ‘OR’
   #2 Intervention(I) ➔ combine MeSH & Keyword with ‘OR’
   #1 ‘AND’ #2 ➔ (combine P & I with ‘AND’)

2. Search for RTCs in PubMed using Randomised Controlled Trials (RCT) filter recommended by Cochrane

3. Export citations to Endnote Library & annotate the ‘Name of Database’

4. Save your search strategy
DEVELOPING SEARCH STRATEGY

b. The Cochrane Library (Wiley)
http://www.cochranelibrary.com/
Cochrane Search Interface

SEARCH FUNCTION

<table>
<thead>
<tr>
<th>FEATURE</th>
<th>Who should use it, What does it do and What’s New</th>
</tr>
</thead>
</table>
| 1 SEARCH         | • For users interested in performing quick searches with a few terms  
                  • For experienced users who prefer to use pull down menus to search fields  
                  • Includes auto-suggest feature **New**  
                  • Supports up to five search rows |
| 2 SEARCH MANAGER | • For searchers interested in creating complex strategies  
                  • Supports Boolean and proximity operators, nesting, and field searching  
                  • Combine search line  
                  • Insert a line, add one search to another and orphan line detection **New** |
| 3 MEDICAL TERMS   | • For users wanting comprehensive searching of medical concepts using MeSH  
                  • Includes auto-suggest feature **New**  
                  • All MeSH information, permuted index, tree(s) and results, on one page  
                  • Improved qualifier search and support for all thesaurus functions |
| 4 BROWSE          | • Browse Cochrane Reviews by: Topic, new reviews, updated reviews, A – Z or Review group  
                  • Browse all other Cochrane Library Databases  
                  • Other Reviews, Trials, Methods Studies, HTA, Economic Evaluations |
Follow step 1-6 to do a MeSH search for intervention ‘jet injection’
Searching Keyword For ‘Intervention’

1. Enter the keywords directly into the search box #2 as shown
2. You can add the suffix : ti,ab to the end of the term
3. Enclose search terms with () before appending : ti,ab if you are entering more than one word in a field search
Cochrane Search Strategy

4. Repeat **MeSH search and Keyword** search for ‘*lidocaine*’
5. Combining concepts on ‘jet injection’ (#3) and ‘lidocaine’ (#6) with ‘AND’ (see search results for ‘I’ in #7)
Cochrane Search Results

Scan the results and retrieve the relevant full text articles

65 Trials matching on "#7 - #3 AND #6"

Cochrane Central Register of Controlled Trials
Issue 1 of 12 January 2019

Filter your results

Year
Year first published
2019................................. 0
2018................................. 4
2017................................. 7
2016................................. 3
2015................................. 4

Custom Range:
YYYY to YYYY

Apply

Date
Date added to CENTRAL trials database
The last 3 months............................. 0
The last 6 months............................ 3
The last 9 months............................ 18
The last year................................. 19
The last 2 years............................. 23

Custom Range:

Cochrane Reviews 65
Cochrane Protocols 0
Trials 65
Editorials 0
Special collections 0
Clinical Answers 0
Other Reviews 0
Save And Manage Search Strategy

Login to your account & save your searches
Open your Endote Library
Double click the downloaded file (‘citation-export.RIS’) to import the citations into EndNote.
DEVELOPING SEARCH STRATEGY

c. Embase (Elsevier)
https://www.embase.com/login
**Subject coverage**
- Biomedical (in-depth coverage of pharmacology, pharmaceutical science and clinical research)
- Medical devices
- Life sciences & Allied Health

**Content:**
- >30% of Embase journal titles are unique (i.e., not covered by MEDLINE)
- >32 million published and peer-reviewed records, in-press publications
- Over 2.4 million conference abstracts indexed from more than 7,000 conferences from 2009
- Coverage of 8,500 indexed peer-reviewed journals from 1947

**Strength:**
- Deep full-text indexing with Embtree thesaurus (75,000+ terms), includes all MeSH terms, particularly strong in drug, disease and medical device terms
Click at ‘Search’ tab, select **PICO**

*Type your search term at the ‘Find best term’ box*
Searching for ‘Intervention’ (‘I’) term

1. In the ‘Find best term’ box, type the Intervention (I) term ‘jet injection’.
2. Corresponding synonyms will be auto-generated.
Searching for ‘Intervention’ (‘I’) term

3. Click at the ‘triangle’ sign.

4. Check the radio button next to the ‘Title or Abstract’ to focus the search of synonyms in title or abstract field.
Searching for ‘Intervention’ (‘I’) term

5. Back to the ‘Find best term’ box, type the Intervention (I) term ‘lidocaine’ and select synonyms (search in title/abstract field).

6. Use ‘AND’ to combine search concept on ‘jet injection’ with ‘lidocaine’ and its synonyms.

7. The PICO Search from will automatically combine all the ‘Intervention’ terms to display the search results.
Export Embase Citations To EN

1. Set number of items.
2. Select the desired number of items to export.
3. Choose 'RIS format' (Merrilee, EndNote).
4. Open Endote software & double click the 'records.ris' file to import the citations to EndNote.
Using EMTREE To Identify Subject Headings

Start search with Browse EMTREE, enter word or phrase without quote
Click Find term

As you type, EMTREE auto suggest subject headings for your selection
EMTREE (Embase subject headings)

EMTREE automatically identifies drug, diseases or device terms & prompts to take query to appropriate search to add subheading, etc.

Hierarchy of Emtree terms, along with number of records:

- Emreee
  - chemicals and drugs
    - cardiovascular agent
      - antiarrhythmic and arrhythmia-inducing agents
        - antiarrhythmic agent
          - lidocaine (68,233 records)
    - agents affecting water, molecule or ion transport
      - ion transport affecting agent
        - sodium channel affecting agent
          - sodium channel blocking agent
            - voltage gated sodium channel blocking agent
              - lidocaine (68,233 records)
    - agents acting on the peripheral nervous and neuromuscular systems
      - local anesthetic agent
        - lidocaine (68,233 records)

History:
This term was added to Emtree in 1974.
REPORTING THE SEARCH

a. The literature search process
b. PRISMA requirements
Reporting Your Literature Search

Methods section

- The names of the database searched (dates of coverage)
- The dates of the last search for each database
- PICO concepts that were searched for
- Limits applied (e.g., publication date, study design, language, etc.)
- Other sources searched (grey literature, handsearching, reference list)
- List individuals or organizations contacted
- Include the detailed search in an Appendix

Record the number of search results retrieved for each database and fill this total number in the PRISMA flow diagram (see next slide)
PRISMA (Preferred Reporting Items for Systematic Reviews and Meta-analyses)

A transparent way of reporting your search results of systematic reviews and meta-analyses

Source: http://prisma-statement.org/prismastatement/flowdiagram.aspx
SUMMARY: DEVELOPING A SEARCH STRATEGY

- Searching is an iterative process
- Revise your search till you are satisfied with the results

Diagram:

1. Formulate the focus question
2. Select databases
3. Build the search strategy (MeSH term + Keywords)
4. Refine the search (Study design (RCTs filter) limits)
5. Analyse the results

Options:

- Use results
  - YES: Satisfactory
  - NO
Systematic Reviews: Critical Appraisal Tools

- The Centre The CASP Checklist https://casp-uk.net/casp-tools-checklists/
- The Centre for Evidence-Based Medicine (CEBM) https://www.cebm.net/2014/06/critical-appraisal/
- Joanna Briggs Institute Critical Appraisal tools https://joannabriggs.org/critical_appraisal_tools
- The Cochrane Collaboration’s tool for assessing risk of bias (See Chapter 8: Assessing risk of bias in included studies) https://training.cochrane.org/handbook
- BestBET https://bestbets.org/links/BET-CA-worksheets.php
- The Newcastle-Ottawa Scale (NOS) for assessing the quality of nonrandomised studies in meta-analyses http://www.ohri.ca/programs/clinical_epidemiology/oxford.asp

Refer to NUS Systematic Review Guides at http://libguides.nus.edu.sg/sysreviews
ENDNOTE

- Remove duplicates
- Exporting EN references to MSExcel
- Backup

OPTIONAL

» Cite While You Write (CWYW) → see Endnote channel on Youtube
» Converting to Plain Text
Finding and Removing Duplicates
Using ‘NUSLib_SysRev.ens’
(a customised EN Output Style) for export to EXCEL worksheet

On your computer, locate where the Endnote Programme folder is
Look for a folder called ‘Styles’

Program Files (x86) > EndNote X9 > Styles

- NUSLib_SysRevs.ens
- Tab_Delimited_Export_To_Excel.ens
- NUSL-TabD-Systematic Review.ens
- Turabian 9th Footnote.ens
- Chicago 17th Footnote.ens
- EndNote Export.ens
- MLA 8th.ens
Exporting EN citations to Excel
(for analysis of results)
Steps To Bring .txt Into EXCEL

1. Open Excel and go to the Data tab.
2. Click on "From Text" and select "From File".
3. Choose the .txt file you want to import.
4. Select the appropriate delimiter and choose the data format.
5. Click "Next" and preview the data.
6. Make sure the data is correct and click "Finish".
Example of Exported References Using ‘NUSLib_SysRev’ Output Style

<table>
<thead>
<tr>
<th>No.</th>
<th>Author</th>
<th>Year</th>
<th>Title</th>
<th>Journal</th>
<th>Volume</th>
<th>Issue</th>
<th>Name of databases</th>
<th>Abstract</th>
</tr>
</thead>
<tbody>
<tr>
<td>437</td>
<td>P. edey and J. M.</td>
<td>2007</td>
<td>Home telecare during intensive</td>
<td>Journal of telemedicine and tel</td>
<td>13</td>
<td>1</td>
<td>Cochrane</td>
<td>We examined the influence of the increased frequen</td>
</tr>
<tr>
<td>478</td>
<td>I. Berin, G. Grange, N.</td>
<td>2014</td>
<td>Nicotine patches in pregnant</td>
<td>BMJ (Online)</td>
<td>348</td>
<td></td>
<td>Cochrane</td>
<td>Objective: To determine the efficacy of 16 hour nic</td>
</tr>
<tr>
<td>426</td>
<td>D. C. Berry, M. Neall, E.</td>
<td>2013</td>
<td>Rationale, design, and methodology</td>
<td>BMJ Pregnancy and childbirth</td>
<td>13</td>
<td></td>
<td>Cochrane</td>
<td>BACKGROUND: Women who are diagnosed with gest</td>
</tr>
<tr>
<td>440</td>
<td>N. Bise, A. Naclol, A.</td>
<td>1997</td>
<td>Telemedicine in the treatment of</td>
<td>Annals of the Institute of Health</td>
<td>333</td>
<td>3</td>
<td>Cochrane</td>
<td>Good glycemic control requires that treatmen</td>
</tr>
<tr>
<td>444</td>
<td>M. Bouhmad, M. V. Ser</td>
<td>2015</td>
<td>Induction of labour versus expecta</td>
<td>Lancet (London, England)</td>
<td>385</td>
<td>9887</td>
<td>Cochrane</td>
<td>BACKGROUND: Macrosomic fetuses are at increas</td>
</tr>
<tr>
<td>443</td>
<td>L. A. Brasero, S. Mong</td>
<td>1999</td>
<td>Comparison of visual and comput</td>
<td>American Journal of Obstetrics</td>
<td>181</td>
<td>5 Pt 1</td>
<td>Cochrane</td>
<td>OBJECTIVE: This study tested the null hypothet</td>
</tr>
<tr>
<td>457</td>
<td>A. L. Brolly, S. Barr, S.</td>
<td>2014</td>
<td>A complex intervention to improve</td>
<td>BMJ Pregnancy and childbirth</td>
<td>14</td>
<td>1</td>
<td>Cochrane</td>
<td>BACKGROUND: Despite the widespread recognitio</td>
</tr>
<tr>
<td>458</td>
<td>A. L. Brolly, S. Barr, S.</td>
<td>2014</td>
<td>A complex intervention to improve</td>
<td>BMJ Pregnancy and childbirth</td>
<td>14</td>
<td>1</td>
<td>Cochrane</td>
<td>BACKGROUND: Despite the widespread recognitio</td>
</tr>
<tr>
<td>454</td>
<td>A. L. Calle-Pascual, N.</td>
<td>2010</td>
<td>The outcomes of gestational dia</td>
<td>International Journal of endoc</td>
<td>775</td>
<td></td>
<td>Cochrane</td>
<td>Objective: To evaluate the feasibility of a talle</td>
</tr>
<tr>
<td>455</td>
<td>P. Carral, M. D. C. Aya</td>
<td>2015</td>
<td>Web-based Telenetiology System</td>
<td>Diabetes technology &amp; therapy</td>
<td>17</td>
<td>5</td>
<td>Cochrane</td>
<td>Objective: The aim of this study was to examine</td>
</tr>
<tr>
<td>469</td>
<td>C. Chiswick, R. M. Rey</td>
<td>2015</td>
<td>Effect of metformin on maternal</td>
<td>The Lancet Diabetes and Endocr</td>
<td>3</td>
<td>10</td>
<td>Cochrane</td>
<td>Background: Maternal obesity is associated with i</td>
</tr>
<tr>
<td>447</td>
<td>J. Dautinger</td>
<td>1992</td>
<td>[Physiology of Doppler blood flow</td>
<td>Der Gynäkologie</td>
<td>25</td>
<td>5</td>
<td>Cochrane</td>
<td>OBJECTIVE: To determine the effect of antenatal di</td>
</tr>
<tr>
<td>431</td>
<td>J. M. Dodd, D. Tournbul</td>
<td>2014</td>
<td>Antenatal lifestyle advice for</td>
<td>BMJ (Clinical Research ed.)</td>
<td>348</td>
<td></td>
<td>Cochrane</td>
<td>OBJECTIVE: To determine the effect of antenatal di</td>
</tr>
<tr>
<td>470</td>
<td>J. M. Dodd, D. Tournbul</td>
<td>2014</td>
<td>Antenatal lifestyle advice for</td>
<td>BMJ (Online)</td>
<td>348</td>
<td></td>
<td>Cochrane</td>
<td>OBJECTIVE: To determine the effect of antenatal di</td>
</tr>
<tr>
<td>429</td>
<td>O. F. Dueñas-García, P.</td>
<td>2011</td>
<td>[Perinatal outcomes of patients</td>
<td>Ginecología y obstetricia de l</td>
<td>79</td>
<td>7</td>
<td>Cochrane</td>
<td>BACKGROUND: Gestational diabetes is one of the m</td>
</tr>
<tr>
<td>430</td>
<td>A. Ferrara, M. M. Hekd</td>
<td>2014</td>
<td>A pragmatic cluster randomized</td>
<td>BMJ Pregnancy and childbirth</td>
<td>14</td>
<td>1</td>
<td>Cochrane</td>
<td>BACKGROUND: Women with gestational diabetes (G</td>
</tr>
<tr>
<td>448</td>
<td>A. Ferrara, M. M. Hekd</td>
<td>2014</td>
<td>A pragmatic cluster randomized</td>
<td>BMJ Pregnancy and childbirth</td>
<td>14</td>
<td>1</td>
<td>Cochrane</td>
<td>BACKGROUND: Women with gestational diabetes (G</td>
</tr>
<tr>
<td>465</td>
<td>J. G. Givens, M. O'Kane</td>
<td>2014</td>
<td>Tel-E-Mum: A feasibility study</td>
<td>for Diabetes medicine</td>
<td>31</td>
<td></td>
<td>Cochrane</td>
<td>Aim: “to determine the feasibility and acceptability</td>
</tr>
<tr>
<td>477</td>
<td>J. E. Harding, J. E. Hage</td>
<td>2015</td>
<td>Randomized trial of neonatal hypo</td>
<td>BMJ Pediatrics</td>
<td>15</td>
<td>1</td>
<td>Cochrane</td>
<td>Background: Neonatal hypoglycemia is common, a</td>
</tr>
<tr>
<td>428</td>
<td>E. Heffley, P. Middlet</td>
<td>2013</td>
<td>The DIAMOND study: postpartum</td>
<td>BMJ Pregnancy and childbirth</td>
<td>13</td>
<td></td>
<td>Cochrane</td>
<td>BACKGROUND: Postpartum follow-up of women wh</td>
</tr>
<tr>
<td>451</td>
<td>E. Heffley, P. Middlet</td>
<td>2013</td>
<td>The DIAMOND study: postpartum</td>
<td>BMJ Pregnancy and childbirth</td>
<td>13</td>
<td></td>
<td>Cochrane</td>
<td>Background: Postpartum follow-up of women who h</td>
</tr>
<tr>
<td>423</td>
<td>C. J. Hornko, L. C. Dee</td>
<td>2012</td>
<td>Impact of a telemedicine system</td>
<td>Diabetes technology &amp; therapy</td>
<td>14</td>
<td>7</td>
<td>Cochrane</td>
<td>BACKGROUND: Health information technology has b</td>
</tr>
<tr>
<td>424</td>
<td>C. J. Hornko, W. P. Sar</td>
<td>2007</td>
<td>Use of an internet-based telemed</td>
<td>Diabetes technology &amp; therapy</td>
<td>9</td>
<td></td>
<td>Cochrane</td>
<td>BACKGROUND: Internet technology has been proven</td>
</tr>
<tr>
<td>458</td>
<td>A. L. Hul, S. Ludwig, P.</td>
<td>2010</td>
<td>Exercise and dietary intervention</td>
<td>during pregnancy results in re</td>
<td>Cochrane</td>
<td>RESULTS: Maternal obesity is associated with the f</td>
<td></td>
<td></td>
</tr>
<tr>
<td>471</td>
<td>A. L. Hul, S. Ludwig</td>
<td>2006</td>
<td>Community-based exercise and di</td>
<td>Canadian Journal of Diabetes</td>
<td>30</td>
<td>2</td>
<td>Cochrane</td>
<td>OBJECTIVE: To determine the feasibility of inte</td>
</tr>
<tr>
<td>463</td>
<td>J. J. Infante, A. O'Dea, P.</td>
<td>2013</td>
<td>Barriers to participation in a com</td>
<td>Diabetes</td>
<td>62</td>
<td></td>
<td>Cochrane</td>
<td>Gestational diabetes mellitus (GDM) is increasing a</td>
</tr>
</tbody>
</table>

Manually insert a header line
Backup Your EN Library

1. Save the complete Library to a single compressed file (.enlx), including .DATA folder.
2. To backup: File > Compressed Library
3. To decompress: double click file
4. ‘Make Stuff Safe’: Save a copy to a secure storage
5. Avoid Cloud storage e.g. DropBox & Google Drive
APPENDIX 1: VIDEOS
HOW TO EXPORT SEARCH RESULTS FROM DATABASES INTO ENDNOTE

PubMed
https://youtu.be/Bndii3dQ1kw

Embase
https://youtu.be/VcJpb0YztkA

Scopus
https://youtu.be/alwH-ENkHIQ

Cochrane
https://youtu.be/QHXWaAZzBqE

CINAHL
https://youtu.be/KWc-G_FlkFQ

PsycINFO
https://youtu.be/4qEh0HsBQGz

Library Subject Guide
http://libguides.nus.edu.sg/c.php?g=145503&p=953994
APPENDIX 2: Endnote’s CWYW functions


Convert to Plain Text (PC)

EndNote tab > Convert Citations and Bibliography
> Convert to Plain Text

A copy of the Word document will be created with no field coding.
Use before sending document to a publisher or submit to IVLE, as the field coding may interfere with other software, e.g. layout applications used by publishers.
Appendix 3: Exporting Large Number Of Results From Ebscohost Database
Please give us your feedback @ http://bit.ly/SRWPharmUG20jun

Thank You!

Medical Library
Walk in: Level 5, MD6
Telephone : 65162046
Email: mdlib@nus.edu.sg
URL: www.lib.nus.edu.sg